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Introduction / Purpose

AutoData is a fully functional Lab Information Management System [LIMS] for small workgroups (< 20 users). In addition, through the use of data acquisition hardware, AutoData can incorporate process information into the same database to allow for integrated analysis of both process and lab data.

The purpose of this manual is to verify:

· The application software is installed properly on the computer.

· The main databases are installed properly on the server.

· The software operate in accordance with design specifications, manufacturers’ recommendations and cGMP.

Installing the Program

AutoData has two components, the User Application and the Server data files.  The User Application is installed using an InstallShield Setup.exe file:
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After clicking “Next”, this screen will disappear.  A few seconds later, you should see:
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Simply launch the Setup.exe file to begin the installation.  Following all of the defaults established by the installation program, you would install the following files in the C:\AutoData folder:
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In this implementation, it is assumed that the server data files are located in the N:\AutoSoft\AutoData\Server\ folder.  In general terms, the server files can be located anywhere on the network.

The installer uses the “CHICAGO.TTF” font and installs it during the installation process.

Often the AutoData LIMS is supplied as part of a hardware package.  In such a case, the software and hardware are supplied “pre-configured” and ready for use.

How information is stored in the program

Since this is a multi-user program, the master copy of all of the data is located on a Server.  Each user keeps separate copies of the data files locally.  This provides 3 benefits:

The user does not have to be connected to the Server to use the program

There is less network traffic

Since the files are being read from the local hard drive, the program runs faster.

There is a problem with this however.  The user could be using old information.

AutoData provides automatic updating of the local files as the master copies change. In addition, the  File->Update Local Information  command allows the user to update the local files.  Upon successful execution, the screen should look briefly like:
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This indicates that information has moved into the local machine.

The files kept in the \Server\Data folder are:
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Depending upon your configuration, you may not have the Adam.*, A4011D.* nor the Thomas.* files which are reserved for data acquisition.  The *.dbf files are data base files, the *.cdx files are the indexes associated with the dbf’s, the *.fpt are memo files associated with the dbf’s, and the Excel files provide links to Excel for graphing results.
As mentioned above, the master Server data folder can be located anywhere on the network.  Therefore multiple copies of the master Server data folder can exist.  This provides the following benefits:

- A separate copy of the Server data folder can be used to train personnel

- Different type of data can be stored at different locations.

There is a significant drawback to this however:

- The user must be aware of which Server data folder is currently in use.

- The user must switch between Server data folders.

Upon startup, AutoData remembers which Server data folder was last used and defaults to it if it can be found.  If the Server data folder cannot be found, the program asks you to find one:
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You simply use the standard Open File screen to locate a file named ‘Beacon.txt’:
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and select it.

The software can always you which Server data file is in use.  Use the File->Status      command:
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This command is always available to the user.  It is the user’s responsibility to assure the correct one is being used.

AutoData will also create additional folders inside the local AutoData folder, which contains the application.  These folders will be created automatically by the software as needed. The include:


\code

\local

\forms

\reports

	Confirmation checklist

	Item
	Initials
	Date

	Location of Server Data Folder:
	
	


Special Text Files

AutoData also requires special text files that are used as toggles to the software to enable certain features.  To enable the desired feature on only selected machines, include the file in the \local\ directory.  To enable the feature on all machines, locate the file in the \server\data\ directory.

	File
	Function

	EraseL.txt
	Allows the user to erase local data before transfer to server

	EraseS.txt
	Allows the user to erase server data

	Thomas.txt
	Enables data logging using the Thomas Engineering protocols

	ADAM4017.txt
	Enables data logging using the ADAM4017 protocols

	ADAM4011.txt
	Enables data logging using the ADAM4011D protocols


	Confirmation checklist

	Item
	Initials
	Date

	EraseL.txt file 
Present
Absent
(Circle)
	
	

	EraseS.txt file 
Present
Absent
(Circle)
	
	

	Thomas.txt file 
Present
Absent
(Circle)
	
	

	ADAM4017.txt file 
Present
Absent
(Circle)
	
	

	ADAM4011.txt file 
Present
Absent
(Circle)
	
	


Login

Upon startup, the following screen is presented:
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Follow the instructions presented on the screen.  

After a user is selected the screen becomes:
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Key in your password, replacing the ************’s.  The password is case sensitive, must contain 6-10 characters including at least one number.

For initial startup of the program, the primary user will be given a pre-configured user name and password to allow for entry into the program.

Menu Options

The menu options will be presented in the order in which initial configuration and validation should be performed.  There is a full menu and an short menu option that is controlled by the settings in the Add/Edit->User screen.

Add/Edit Menu

Full Menu:
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Short Menu:
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Add Users

This screen looks like:
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Highlight a user and toggle the check boxes to enable and disable program features. Note the IC# Prefix entry block.  Here, a letter (A-Z) can be entered.  This is for manual creation of IC numbers.  When the user creates an IC number, this prefix will be added to the front of it.  See Edit/Add IC screen discussed below.

In the case of selecting “Default to Data Entry”, the screen becomes:
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	Confirmation checklist

	Item
	Initials
	Date

	Add user to list
	
	

	View or print user report to confirm user is on list
	
	

	Log into program as created user
	
	

	Confirm selected functionality is enabled or disabled as configured
	
	


Add Equipment Types

This screen is:

[image: image16.png][-[oIx]

File Enter LogData Report Add Import

Type New Equipment Type and [Return] to add to list | Finish F2.

[Equipment Type
Eagger

Einacchi

Cello Wrap

Clear Soap

Condor

Crutcher

Div. 5 Syndet/Eulk
Dryer

Electric Fill

Hand Pack / Rework
K-Press & Misc.
Kettle

0ff-Line Pack Mach.
Pleat Wrap
Pre-Milling

Process Other

STy

2 Not Specified





Just follow the instructions to add equipment types. 

	Confirmation checklist

	Item
	Initials
	Date

	Add equipment type to list
	
	

	View or print report to confirm equipment type is on list
	
	


Add Equipment
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Again, carefully follow the instructions on the screen to successfully add equipment.  After an equipment type is selected the screen becomes:
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and the equipment description can be entered.  All equipment entered must have an associated equipment type.

	Confirmation checklist

	Item
	Initials
	Date

	Add equipment to list
	
	

	View or print report to confirm equipment is on list and linked to proper equipment type.
	
	


Add Test Methods
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A test method number and name must be entered.  The number can be alphanumeric if desired.  Checking the Attributes box will allow multiple attributes to be assigned to a test method.  Checking the Quantitative box will make the entered results quantitative.  It is recommended that test methods be made quantitative whenever possible.  Note that the test method must be quantitative if multiple attributes are to be assigned.

	Confirmation checklist

	Item
	Initials
	Date

	Add test method to list
	
	

	View or print test method report to confirm test method is on list
	
	

	Attributes feature properly enabled/disabled
	
	

	Quantitative feature properly enabled/disabled
	
	


Add Attributes
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Again, follow the on-screen instructions.  Note that only those methods that have had multiple attributes enabled are displayed.  Do not check the Calculated Attribute check box.  This feature has not yet been fully implemented.

	Confirmation checklist

	Item
	Initials
	Date

	Add attribute to list
	
	

	View or print attribute report to confirm attribute is on list
	
	

	Attributes properly map to assigned test method
	
	


Add Inventory Items
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Follow the on-screen instructions.  It is very important that one of the three buttons at the top of the screen be clicked to record changes.  

Note at the bottom right the check box “Show Tool Tips”.  Toggling this box will result in the appearance of tool tips on many of the buttons to aid the user in navigating this screen.

As a default, all of the IC numbers will appear.  In the above example, there are 14340 IC numbers. One can filter the list to display only those IC numbers that match the entered criteria.  For example:
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Here 13 records match the location “H-1”.  The selection, “020346”, has both an MSDS sheet, filed on Oct. 1, 1995, and a sample, received on Apr. 23, 1998.

The “Increment Next IC” command will create a new record using the letter prefix assigned to the current user as described in the Add User section above.  The next available number will be automatically assigned.

	Confirmation checklist

	Item
	Initials
	Date

	Add inventory control number to list
	
	

	View or print inventory item report to confirm IC is on list
	
	

	All properties of IC numbers are mapped properly
	
	


Add Inventory Groups

Inventory groups are used by the reporting function to allow the user to define a subset of inventory items.  Test results for this subset can be generated.  For example, if one wanted to report on the color of all fats, one would select the user defined Fats group in the Report Result screen.  The resulting report would include all inventory items assigned to the Fats group in one report.  This would save the user considerable time over running multiple reports, one for each inventory item.

The screen starts as:
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To review the entries in an existing group, click on it to reveal:
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The left hand side allows the user to filter the inventory list for only those items which match the IC Filter entry (in this case, tallow)
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Double clicking on the inventory item in either list adds or deletes it from the selected group.

To add a new group to the group list, enter its description in the Enter New Group box and then click on the Add New Group to List button.
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	Confirmation checklist

	Item
	Initials
	Date

	Add IC group to list
	
	

	View or print IC Group report to confirm group is properly defined
	
	


Add Specifications -> QC Specifications

Entering QC [Quality Control] specifications is similar to adding test results. 
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Each specification requires the following information:

· Inventory control number

· Test method (if the method has multiple attributes, specifications can be added for each attribute)

· Unit of measure of test

· For quantitative test, the upper and lower control limits.

· For qualitative tests, the aim, which is a character, string.  Typical examples of this are “Pass”, “Matches Std”.

The IC Search and the Method Search functions are identical as data entry.

A quick note on the assignment of specifications for test methods, which result in negative numbers.  Remembering high school mathematics, the number –2 is less than the number –1.  So a specification which spans the values –2 to –1 would set the lower control limit at the smaller value, in this case –2, and the upper control limit to the higher value, in this case –1.  Also, the alarm limits can equal but not exceed the control limits (i.e. LCL  LAL, UAL UCL).

Here is an example of a specification entered for a test method with multiple attributes:
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	Confirmation checklist

	Item
	Initials
	Date

	Add specification
	
	

	View or print specification report to confirm information is correct
	
	


Using AutoData to help determine specifications

A tool to help set specifications is the Suggest Specification button.  This button will search the data base for all test results for the IC number and test method entered, and report the Max, Mean, Min, ±1 sigma and ±2 sigma values.  For example:
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Here, the max is 3.66, the +2 sigma is 3.800, the +1 sigma is 3.53, the average is 3.27, the-1 sigma is 3.00, the –2 sigma is 2.74 and the minimum value is 2.90.  There were 8 data points in the period 12/20/1998 – 12/20/1999.  Clicking on the will move the calculated values into the specifications.

Using AutoData to copy existing specifications to additional inventory items

A tool to help set specifications is the Copy All Specs of This IC to Another IC button.  First, make sure a valid IC number is entered.  Clicking on this button will reveal:
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Enter the IC number to copy to or use the IC Search button to pick it from the list:
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Upon clicking on the Execute button, the program scans the data base and reports the number of specifications that already exist for the second IC number:
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Clicking OK will allow the user to determine which specifications, if any, are to be overwritten:
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The program will work its way through the specifications, prompting for overwriting if necessary.  Save and Continue does not have to be clicked.

	Confirmation checklist

	Item
	Initials
	Date

	Copy specification from one IC to another
	
	

	View or print specification report to confirm information is correct
	
	


Add Specifications -> QA Specifications

QA [Quality Assurance] specifications are detailed instructions for the production workers and Quality Assurance technicians on the shop flow.  The QA Specifications describe the sampling and inspection requirements for the finished goods.  The QA Specifications are customer specific, however one QA Specification will often control multiple products (IC Numbers). The screen looks like:
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The QA Specifications are indexed by a 4 digit number.  Simply entering the number in the upper left hand box and hitting the [Return] key will display the desired QA Specification.  

A QA Spec picker screen is available if required:
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This screen works identically to other “picker” screens already discussed.  Each QA Specification is assigned a unique 4 digit number that cannot be modified by the user.  The user can change the QA Spec description at any time.

In a similar fashion, the Customer number (which is a 10 character alphanumeric) can also be entered.   A customer picker screen is also available if required.  Each QA Spec has identically one customer assigned to it. The assigned customer can be changed at any time.  One customer can have more than one QA spec assigned to it. Neither the customer number nor description can be edited on this screen.  

The First, Next, Prior, and Last buttons allow the user to navigate through the QA Specifications list.  They are presented in numerical order.

The New Blank button creates a new QA Spec, automatically numbered, with all blank fields.

The Clone button creates a new QA Spec, automatically numbered, with the sampling and inspection fields containing the same information as the active QA Spec when the Clone button was clicked.

The Preview button allows the user to view the active QA Spec on the screen as it would appear printed.

The Print button prints one copy of the QA spec and revision sheet.

The Delete button deletes the active QA Spec.  The user is given a chance to change his/her mind:
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The Finish button exits the QA Spec editing routine.

The Originator is a read-only field.  The user who creates the QA Specification is the Originator.

The Origination Date is a read-only field and completed at the point in time the QA Spec was created.

The GMP check box is for GMP products.  The OTC check box is for OTC products.  An OTC product is also a GMP product by default.

The PQL level can have a value from 1 to 4.

Each QA Specification must be assigned at least one IC number.  Many IC numbers can be assigned to a single QA Specification.  There are two ways to assign IC numbers to a QA Spec.

If the IC number is known:
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Simply enter the IC number in the Add IC # box and hit [return].  If the IC number is known the software will add it to the list on the right.

You can remove an IC number from the list by double clicking on the IC number in the list.

If the IC number is not known:

Click on Expand IC Information to see:
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The left hand box allows the user to filter the IC numbers based on a text string in the description.  Double click on the left side list to add an IC to the right side list.  Double click on the right side list to remove an IC from it.

The QA Specification routine tracks changes in every QA Spec.  A revision description must be manually entered in the text-entry box just to the right of the words Enter Here. Once an entry has been made, The Add Revision button appears and must be clicked to add the new revision information.  The revision date is automatically assigned. 

Clicking on Expand Revision Information can expand the revision information.  The screen can take its original appearance by clicking the Display All Information button that subsequently appears.

The Sampling Information and Inspection Information fields are free-form text entry boxes.  They can both be expanded if desired. The Edit menu is available if desired:
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	Confirmation checklist

	Item
	Initials
	Date

	Add QA specification
	
	

	View or print QA specification report to confirm information is correct
	
	


Spell Checking the QA Specification Sampling and Inspection fields

Clicking on Spell Check in either the text entry field brings up the following screen:

This is a third party spell checker, FoxSpell by Strategic Edge.  The commands are typical of a standard computer spell checker.  The following is an excerpt from the FoxSpell manual:

USING FOXSPELL CHECKER

Once the spell checker is called, it immediately starts spell checking.  As soon as a word is not found in the dictionary, checking stops and the user is presented with this form:[image: image40.png]| O futobata Lab Information Management System — @ AutoSoft and J. Serdakowski, Pho.____ MEIE]
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Below are explanations of the above buttons.

	BUTTON
	ACTION PERFORMED BY THE BUTTON

	Suggest
	Suggest alternate spellings for the currently selected suspect word.  This button is only shown if the FS_SPELL.PRG variable named lAutoSuggest is assigned to a logical false.  Since the default value is true, suggestions are automatically generated and thus this button does not appear on the form.



	Add word
	Add the suspect word to the dictionary



	Undo add
	Remove from the dictionary a word that was previously added to it.  Pressing this button brings up a dialog that shows the most recently added word during the spell checking session. The user can either delete this word or type in another word to be deleted from the dictionary.



	Replace
	If the user presses the Replace button after typing in a replacement word, the suspect word will be replaced with the user's entry.  



	ignore Word
	Ignore just the current occurrence of the suspect word.



	Ignore all
	Ignore the current and all future occurrences of the suspect word within the spell checking session.



	Cancel
	Stop spell checking and exit without saving any changes that were made.



	Exit & save
	Stop spell checking, exit and save all changes.


Customers

The Customer editing screen is consistent with the other screens.
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	Confirmation checklist

	Item
	Initials
	Date

	Add customer
	
	

	View or print customer report to confirm information is correct
	
	


Add/Edit Stored Reports

This command requires advanced training and should only be used by qualified personnel.

This command reveals:
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This screen is quite comprehensive and difficult to manage.  First, the New Saved Report button in the upper left clones the active report (in this case “Bradpride Lot”) and adds a “2” to its name.  The list on the left is the list of all the currently saved reports.  Activate one by clicking on it.  Its name will appear in the box below the list.

The check boxes on the right correspond to the different check boxes on the Report Results screen.  The Start Days from Today and End Days from Today apply to the case of a report that spans a particular time range that is a relative time.  Edit this in the standard fashion.

The bottom part of the screen represents the SQL (Standard Query Language) representation of the conditions placed upon the report.  Note that there are four “Select” tabs, Select 1, Select 2, Select 3, Select 4.  This is because SQL statement can become quite long and the editor is limited to 256 characters.  In this case, the SQL statement overflows the Select 1 tab and spills into the Select 2 tab below:

[image: image43.png]New Saved Report

single Click to Select
Double Click to delete from list

[Bradpride Lot
bryer quality
bryer quality comp
Kettle quality
Kettle quality Comp

Bradpride Lot

select 1 Seiect 2

™ Test File to Disk

L=1ofx]

I” Short to Screen  Finish F2

I” Comprehensive to Screen [~ Short to Printer
I” Comprenhensive to Printer [~ Save to Ist Data File

I” summary to Screen
I™ summary to Printer

I” Graph to Screen
I” Graph to Printer

I” save to 2nd Data File
I” save to 3rd Data File

I” 2 Param Graph to Screen
I” 2 Param Graph to Printer
I” 3 Param Graph to Screen

I Comprenhensive 2 to Screen [~ 3 Param Graph to Printer
I Comprenhensive 2 to Printer [ Lot Report to Screen

I” summary 2 to Screen
I” summary 2 to Printer

I Lot Report to Printer
I” Lot Report to Screen

I Comprehensive 3 to Screen [ Lot2 Report to Printer

I” Comprehensive 3 to Printer

I” Out of Spec to Screen
I” Dut of Spec to Printer

Select 3 Select 4

Start Days from Today] 149

End Days from Today] @

ND ad_c_metho - gmethod.gm_c_metho ORDER EY.
ad_c_lot,ad_c_metho,ad_c_atiri,ad_d_date,ad_c_time





Great care must be taken to properly edit this lines or else the SQL call will fail.

The Header statements are more forgiving but still need great care for editing.
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Do not change the location in the header for the Dates mm/dd/yyyy – mm/dd/yyyy section.  In the case of relative dates, the software will automatically update this information every time the report is run.  The software expects to see the dates in the exact place as displayed above.  The other information in the Header can be edited as desired.  Again, 256 characters are the limit, so a Header 2 tab is provided for overflow.

Add/Edit Report Groups
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This screen is analogous to the IC Groups editing screen and functions much in the same way.

Email

If data logging is in use, the software has the option to send a daily status report as an email.
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This is functional, but limited.  Contact AutoSoft for a custom module to allow for more flexible email options.

File Menu
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Change Password

The user is presented with:
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If the password entered is correct, you will see:
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You must enter the password in twice, and the entries must be identical. 

[image: image50.png]Microsoft Visual FoxPro B[] 3
Eie Erfer LogDeta Hepot) Add
iigie

Re-Enter New Password:

—





	Confirmation checklist

	Item
	Initials
	Date

	Change password
	
	

	Confirm new password works and old one does not
	
	


Change User

The change user command brings up the login screen:
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This proceeds identically as described earlier.

Reset Beacon

This command reveals:
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as described earlier.  The keyboard shortcut [Ctrl]–[B] can also execute this.

Status

This command reveals:
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This screen provides the version number, the user, the date and time this status screen was last updated, the server and the number of local records that need to be transferred to the server (See Transfer Results below).

	Confirmation checklist

	Version #
	Initials
	Date

	
	
	

	 
	
	

	 
	
	

	 
	
	

	 
	
	


Update Local Information

This command updates the local copies of the master database files.  The keyboard shortcut [Ctrl]–[U] can also execute this.

Transfer Results

The information manually entered or automatically acquired by each individual computer is stored on the subject computer and only on the subject computer until this command is executed.  Once the data has been moved to the Server, it is removed from the local machine.  This operation is very important.  Unless the data has been moved from the local machine to the Server, the data is not available for further analysis.  The keyboard shortcut [Ctrl]–[T] can also execute this.  If the server is not available, you will be notified:
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If the transfer is successful, you will see a screen relating how many records were transferred:
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Erase Local Data

This command erases all the data accumulated on the local machine without transferring it to the Server.  Some installations will not want this feature enabled for security or accountability reasons.  This feature is only enabled if a file entitled “EraseL.txt” somewhere in the AutoData file system.

Erase Server Data

This command reveals: 
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This action will delete Server data on or before the selected date.  A status bar indicates progress. Some installations will not want this feature enabled for security or accountability reasons.  This feature is only enabled if a file entitled “EraseS.txt” somewhere in the AutoData file system.

Quit

This will exit the program.  If there is any data stored locally that has not yet been transferred to the Server, the software will ask if it should be transferred before the program terminates.
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Edit Menu
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These are standard text manipulation commands found in standard word processor and spreadsheet programs such as Microsoft’s Word© and Excel©.  These commands will be enabled at times when it makes sense to use them.

Enter Menu
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Enter Results

This screen appears:
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This is the screen where the analytical results are entered.  The fields to be completed are:

· Inventory Control [IC] Number

· Lot Number.  Entering information in this field is optional.

· Date and time of sample

· Test method (a test method can have one or many results.  If one test method has more than one result, it is said to have multiple attributes)

· Equipment type.  The program is setup to support a manufacturing operation.  In manufacturing, there can be multiple pieces of equipment (e.g. production lines) which all perform the same or similar function(s).  It then makes sense to group these similar pieces of equipment into one equipment type.  This could help in subsequent analysis of the data.  Entering information in this field is optional.

· Equipment.  This is the piece of equipment or production line from which the sample was taken. Entering information in this field is optional.

· C of A (Certificate of Approval) Required.  This is a check box to indicate if a C of A is required.  Entering information in this field is optional.

· Approved.  Entering information in this field is optional.

· In Process. This is to indicate if the sample analyzed is still in the process of being brought into specification and is NOT the final sample of the product.  Entering information in this field is optional.

· U of M. Unit of Measure.  The computer automatically enters this if the IC number has a specification for the selected test method.  Entering information in this field is optional.

· Notes.  A free form text entry field for notes.  Entering information in this field is optional.

If the IC number is not known, one can click on the All IC Search button or use the [F2] key to reveal a list of all IC numbers.  Follow the instructions on the screen.
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Depending upon the site, this list can be quite large.  Typing in a character sequence in the text entry box allows the user to filter by this character sequence.  

Here, “Tallow” is entered:

[image: image62.png]Microsoft Uisual FoxPro [l
Fie Erter LogData Bepot Add lmport

ck Inventory Item

sh (Select) F2

Enter part of the description here:

tallow Search Description F5

Use the [Tab] key to move to and from entry and list.

Use the [Arrow] keys to move up and down list.

600034 [TALLOW CRUDE REGULAR
800842 [TALLOW REGULAR - F1LTERED, ELEACHED
800064 |TALLOW EDIBLE/CRUDE UNFILTERED
0800068 (TALLOW INEDIBLE EFT

800091 TALLOW EDIBLE

11031{COCO-TALLOW FATTY ACID ELEND
811033|co/Tallow Fatty Acid 68/48 Elend
811546 Tallow Fatty Acids

811550(TALLOW FattyAcid PARTIAL HYDROGENATD
0624867 |HYD TALLOW F.A.(NEUTRER)(PRIFATOZ13)
951218 [Tallow Tr ET 3859000

rident Tallow Translucen
220018 [anslucent Tallow (Trident)Kettle Pha
220114|TALLOW/CASTILE EXTRUDE - KETTLE
225022anslucent Tallow(Trident)Crutcher Ph
225153TallowCombo LEVERZBABTYPE CRUTCHER
230101 |BASE Tallow Soap Putty
235065Tallow Castile in Ein Base





In this fashion, one can cull through a large list of IC numbers to find the desired one.  Select the desired one by highlighting it. To return to the main screen, do one of the following:

Double click on the desired IC number

Hit the [F2] key

Click on the Finish (Select) button

The selected IC number is automatically entered, and its description appears:
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If you know the IC number, you can enter it in directly without having to go to the selection screen.  If it is a valid IC number, its description appears.  You can enter an IC number which has not yet been defined, but its description will be returned as Not Found.
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The lot number can be entered if desired.

The Date and Time default to the current date and time.  You can edit the date by clicking on the desired number and typing, or by using the arrow to the right of the date to reveal a calendar:
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The time can be edited in a similar fashion.

The Test Method can be selected from a list in a similar fashion as the IC number:

[image: image66.png][_[oIx]

Fle Erter LogData Repot Add Impott

ck Test Method

Enter part of the description here; __Finish (Selecti 2|

fatty Search Descri

n Fs

Use the [Tab] key to move to and from entry and list.

Use the [Arrow] keys to move up and down list.
Fatty Acid Anaiysis

8019 |Fatty Acids from Triglyceride

8020 |Fatty Acid Preparation

8023 |Free Alkali & Free Fatty Acid

6841 [Total Soap and Fatty Acid Determinat





Or it can be typed in directly.  If a Test Method has been selected which has specifications for the selected IC number, the specifications are displayed.  If a Test Method has multiple attributes, all of the attributes for the selected test method are displayed.
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Here, the product being tested is Edible Tallow.  The test method is Fatty Acid Analysis.  This method has several attributes that are the carbon chain length distribution by percent of the various fatty acids in the edible tallow.  The active attribute is C15 that has a test result of 3.5%.  This value is in specification.  The specification is defined as:

UCL
[Upper Control Limit] 
5.50%

UAL 
[Upper Alarm Limit]
4.25%

LAL 
[Lower Alarm Limit]
2.75%

LCL
[Lower Control Limit]
0.00%

The Check box to the right of the result when checked indicates that the attribute will be saved to disk.  In this case, the C08 and C10 values will not be saved to disk because for this particular sample there were no results.  The user can check and uncheck these check boxes as desired.  The user can also overwrite the default specification for this particular sample.  The default specification is not altered for subsequent samples.  

In an attempt to trap data entry errors, if an entered result exceeds the control limits, a message appears:
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In this case, the user entered a result of 0.4000 where 0.3000 was the upper control limit.  Clicking Okay resumes program execution.

	Confirmation checklist

	Item
	Initials
	Date

	Enter result
	
	

	Transfer results to server
	
	

	View or print result report to confirm information is correct
	
	


Creating New Specifications using the Enter Results Screen

If a test method is selected that does not yet have specifications for the selected IC number, the screen will look like:
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Note the inclusion of the red message “NO SPECIFICATIONS FOR THIS IC AND METHOD” and the appearance of the button “Create New Specifications Using These Targets”.  The control and alarm limits that are entered will become part of the permanent record and apply to a future instances of this IC and test method.  There are two important features of this function:

· Once the button is clicked, the new specification is created even if the Finish and NO Save button is subsequently clicked.

· The new specification will not display on other samples for the IC number and test method until the screen is closed and re-opened.

	Confirmation checklist

	Item
	Initials
	Date

	Add specification
	
	

	View or print specification report to confirm information is correct
	
	


When all of the data has been entered, the user can do one of the following:

Finish and Save – this will save the data on the screen and exit the data entry screen.

Finish and No Save – this will NOT save the data on the screen and exit the data entry screen.  Data saved with the third option, Save and Continue would have already been saved and is NOT undone by this command.

Save and Continue – saves the data on the screen and wipes the screen clean so that additional data can be entered.

Show Only Methods With Specs [F7] - This button searches the Specification database for all specifications associated with the selected IC number.  The search may take a few seconds an a red and blue status bar is presented to inform the user of this:
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When the search is completed, the screen looks like:
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All of the methods and attributes with specifications for this IC number are presented.  When the user enters a result for a particular attribute, the save check box is toggled on.  Again, only those attributes with toggled-on save check boxes will be saved when the Finish & Save or the Save & Continue commands are executed.

Again, remember that the data that has been entered has been saved to the local machine only, and must be transferred to the Server in a separate operation.  

	Confirmation checklist

	Item
	Initials
	Date

	Enter IC for which methods/specs have been defined
	
	

	View screen to confirm information is correct
	
	


Edit Local Results 

If the installation warrants it, this data can be edited or deleted before it is transferred to the Server using the Edit Local Results command, which reveals:
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Here, the yellow columns cannot be edited, the white columns can.  Result N means a numeric or quantitative result.  Result C means a non-numeric or character result (e.g. “Pass”, “Match Standard”).  More on quantitative results later.

Selected rows can be deleted by clicking on the small box on the left and turning it black:
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Here, the second and third entries have been deleted and will not be transferred to the Server.

Edit Server Data
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This editor is similar to the Edit Local Data editor but is of very limited use and should not be used in most implementations.

Log Data Menu

[image: image75.png]File Edit Enter | LogData Report Add/Edit Import
Thomas Engineering
ADAM 4817

ADAM 40110





There are currently three data logging modules, a data logger specific to pill coating equipment manufactured by Thomas Engineering, a generic data logger for a single ADAM 4017 analog input module manufactured by Advantech, and a generic data logger for one to eight ADAM 4011D modules also manufactured by Advantech.

The logged data is written to the local machine only.  The Transfer Results command in the File menu must be executed to download the data to the Server so that it can be viewed and exported to Excel for analysis.

Thomas Engineering

This screen looks like:
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In order for the data logging module to work properly, data logging hardware must be connected to the COM1 port of the computer.  Consult the data logging hardware section for more details.  

Also, the software has to be told that a data logger is present, and at what software “address”.  To configure this address, click on the small  *  button in the middle of the screen:
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This yields:
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This is the address of the two ADAM-4017 modules that are the “guts” of the data logging hardware.  These numbers must match the sequence number of the specific ADAM-4017 modules as listed in the ADAM driver software.  See the Thomas Engineering hardware section of this manual for more details.  Needless to say, once it is set, it does not need to be changed.  The Hide button will do just that.

The following sample parameters can be entered:

· Inventory control number (using the same IC Search routine)

· Lot number

· Notes

The fields with the white background are read-only fields.  The user can enter information into the fields with the yellow background.  Proper setup of the data logger requires data entry into 103 input fields.  If different experiments are being conducted at different times, the user may be required to change one of more of the data entry fields.  If the user then wishes to return to a prior configuration, the user must then re-enter the old information in the fields that were previously changed.  The use of multiple Data Schemes eliminates this problem.  The user can create a New Scheme at any time that is a clone of the currently active scheme.  The values of all 103 input fields are carried into the new scheme.  Any changes the user makes to the input fields of the new scheme do not affect the values entered while under the old scheme.  The user can then return to the old scheme by selecting it from the drop down menu.  The new scheme is saved and can be recalled as desired.  All user created schemes can be deleted if no longer needed.  There is no un-delete feature.  

The parameters that are measured by the Thomas Engineering data logger are listed at the lower left:
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These values derive from analog voltage signals originating in the Thomas Engineering equipment.  These numbers must be properly calibrated to be meaningful.  The Calibration panel does this:

[image: image80.png][-[0Ix]

Eile Enter LogData Report Add Import
Data Scheme: i

tDefault g
Zstart Logging F3

New Scheme | Delete Scheme

Read One F4
Write One F6

Calibration | Control Limits | Read/write/Plot

1 ot 5 Uoit Unit of Measure
1.0000 soo00  [Psi
1.0000 soo00 [P
1.0000 soo00 [P
1.0000 soo00 [P
1.0000 Soo00  [Psi
1.0000 Soo00  [cM
1.0000 soo00 [P
1.0000 Soo00  [Psi
1.0000 Sooo0  [cPM
1.0000 Sooo0  [RPM





Here, the user must enter the values of each parameter when the Thomas Engineering equipment outputs both 1 and 5 volts.  This is included in the Thomas Engineering documentation.  There may be a need to “tweak” the values ever so slightly to get better agreement with the local display.  This “tweaking” can be done while data logging is in progress. The Unit of Measure should also be entered here.

	Confirmation checklist

	Item
	1 Volt
	5 Volt
	Initials
	Date

	Pan Load Delta P
	
	
	
	

	Exhaust Dew Point
	
	
	
	

	Exhaust Temperature
	
	
	
	

	Inlet Dew Point
	
	
	
	

	Pan/Room Delta P
	
	
	
	

	FPM (CFM)
	
	
	
	

	Inlet Temperature
	
	
	
	

	Atom. Air Pressure
	
	
	
	

	Solution Flow
	
	
	
	

	Pan RPM
	
	
	
	


The Control Limits panel is included to be consistent with the rest of the AutoData software:
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The entries made here will impact the appearance of the strip chart recorder(s) that can be displayed when data logging is in progress. These settings should not be overlooked.

The Read/Write/Plot panel appears as:
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This tells the software which parameters to read, write and plot, as well as the frequency to do same.  Only choose the parameters and frequency that are required, since data accumulates quite quickly.  For example, setting all parameters on and at 10 second frequency will result in 6,000 data points every hour. 

There is significant computational overhead associated with plotting data.  Each parameter has its own strip chart and the screen will quickly fill up with strip chart recorders.  It is strongly advised that only 2 or 3 key parameters be plotted at a time.  The user should experiment with this feature to determine the best mode of operation for the particular installation.

The plotting screens look like:
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Each parameter has its own screen.  The time is the “x” axis.  Values outside of the control limits are shaded pink.  Areas within the control limits but outside the alarm limits are yellow.  The red line indicates the value of the parameter.  Again, the setting of the control and alarm limits dictate the values of the “y” axis.

The calibrations and notes fields can be edited during data logging.  Both items will update in real time so the notes field can be used to “tag” a subset of data for later extraction.  The “Read”” and “Write” fields can also be toggled in real time with the proper cause and effect.  The “Plot” fields can also be toggled but will not affect the strip charts that are currently running.  The limits fields and the frequency fields are disabled during data logging.

You can close a strip chart recorder at any time without affecting the data logging.  Once a strip chart recorder is closed, it cannot be re-opened unless data logging is stopped and then re-started.

ADAM 4017 Data Logging

The ADAM 4017 data logging screen is a generic form of the Thomas Engineering screen.  It is set up for multiple ADAM 4017 analog input modules, and the user can define what parameters are being measured.  8 analog inputs are available on the ADAM 4017.
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Again,  the user can enter directly or look up IC numbers.  Since it is possible to have the 8 analog inputs all monitoring different products, each of the 8 analog inputs can be assigned a unique IC number.  Clicking on the • pastes the IC number currently in the upper left box into the associated row. You cannot type in the IC number directly.  This is done to allow the software to look up the description and automatically enter it as well. The Lot number can be typed in directly. The description of the measured parameter must also be entered for each of the 8 signals.

The IC description is available on the Desc’n panel:
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Notes can be entered as well.
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The data schemes are identical in function to the Thomas Engineering screen:
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The address of the ADAM 4017 is entered in the same way as well:

[image: image88.wmf]
The address of a device is the order it appears on the Advantech ActiveDAQ configuration screen, discussed later in this manual.

The RS-485 communication protocol will support up to 255 ADAM 4017’s on one computer.  AutoData will support multiple ADAM devices as well.  The In Use check box above controls this feature.  If the active scheme is checked as being In Use, then the selected ADAM ports will be logged as configured.   

Since the value for the Address uniquely defines the ADAM 4017 address, to log data from more than one ADAM 4017, simply enter the different addresses of each ADAM 4017 in each scheme, and then check the In Use box.  All schemes that have a checked In Use box will be logged.  Recognize that when several ADAM 4017’s are on the same computer, and each ADAM 4017 has multiple data ports, it is quite possible to totally fill the screen with strip chart recorders and to overburden the computer with an impossibly high number of unit operations.  Common sense must prevail.

It is possible to do something that is quite nonsensical.  Simply activate more than one scheme with the same address, and you will be logging the same data two or more times, possibly with different calibrations as well.

There is no substitute for stupidity!

The Calibration, Control Limits and Read-Write screens are also almost identical:
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Note however, that the reading, writing and plotting frequencies are global variables.  This means that the values entered here apply to all schemes, and are not different for different schemes as they are in the Thomas Engineering case.

ADAM 4011D Data Logging

The ADAM 4011D data logging screen is very similar to the ADA 4017 screen.  It is set up for up to eight ADAM 4011D analog input modules, and the user can define what parameters are being measured. 
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Each ADAM 4011D also includes a Digital Input port.  This port can be toggled between “High” and “Low” and the data logging can be influenced as a result.  Assigning IC numbers is done in the same fashion as for the ADAM 4017 screen however, two different IC numbers can be assigned, one each corresponding the “High” and “Low” status of the digital input port.

The Configuration panel looks like:
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Here the unit of measure and the address of a device is entered. The address is the order it appears on the Advantech ActiveDAQ configuration screen, discussed later in this manual.

The lot number, like the IC number, can have two different values based on the status of the digital input:
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The equipment type and equipment can be assigned:
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Select the “type” first and only those pieces of equipment that match the selected type will be available on the list.

The Read-Write screen is slightly different than the ADAM 4017 screen:
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Here the user can opt to write the data to the disk conditional upon the status of the digital input port.

Report Menu
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Report Results

Recall that all of the master data resides in a file named “ad_data.dbf” on the Server.  Of course, this data file is the master file.  There is a copy of the “ad_data.dbf” file kept locally on each machine to reduce network traffic and improve performance.  This copy is updated every time the program is started and every time the File -> Update Local Data command is executed. The Report->Report Results menu item uses this data file for running reports.  This file can grow to hundreds of megabytes in size.  In order to be working with the most current information, the user must remember to update the local copy of the master data file.  In most implementations, the automatic update will be sufficient to keep every user current.

Remember that the data has been entered with many different parameters.  They include:

· Inventory Control number

· Lot Number

· Date and Time of sample

· Test method (and sometimes multiple attributes)

· Equipment type

· Equipment

· Note

The user is able to filter and sort the data in order to present a subset of the data based on one or more of the above parameters using a variety of formats.  The rule of thumb is that if a parameter is not specified, all values of that parameter will be displayed.  For example, if you wanted to look at all of the IC numbers in the database, you would not enter any value in the IC number entry box.

This screen looks like:
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There are a lot of options here.  The basic strategy is to configure the screen to do exactly what is desired and then click on the Execute button.  The software will do exactly what is requested, the problem lies with formulating the request properly. If multiple options are selected, only results that match all of the options will be displayed.  It is quite easy to define search criteria which is so very restrictive that none of the test results match the defined criteria.  If that is the case, you will see the message 
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without any results being displayed.

Quick Reports

The first box on the screen in the upper left corner is the QUICK REPORTS option.  This is an option for printing re-defined reports that have been previously configured and saved.  This box is a drop down menu that presents a list of all pre-defined report groups:
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Selection of the desired report group will automatically execute all pre-defined reports in the selected report group.  Defining report groups will be discussed later.

The next box on the screen is the IC number box.  Here the user can elect to leave it blank to see all of the IC numbers, or enter in a specific value to see only one of the IC numbers.  A Clear button is provided to remove an entry if so desired.  There are additional Clear buttons next to other text entry boxes throughout this form.

IC Groups

In some cases, the user may want to look at results for more than one IC number, but only a selected group of IC numbers.  Checking the “Use IC Group Selected Below” box reveals a pull down selection box:
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Here, user defined groups of IC numbers are displayed.  One of these groups can be selected resulting in the displaying of the data from all IC numbers in the selected group.  Defining these groups will be discussed in a later section of this document.

Lot Number

A specific lot number can be entered if so desired.

Date Ranges

A date range must be selected.  The default date range is the last year.

In the case of defining a report to be saved for later use, the checkbox Relative Dates is available.  One would check this box if one were interest in defining a report that would present the results of a particular set of tests for a date range that moves in time, but has a fixed relationship to the current date.  For example, if one wanted to look at the test results for the prior 7 days.  If the box is checked and a report is generated on 12/1/2000 to view the test results from 11/23/2000 – 11/30/2000, then when the saved report is again generated, say on 5/1/2001, the date range sampled would be 4/23/2000 – 4/30/2000.  If the box is not checked, then the results sampled would span the dates 11/23/2000 – 11/30/2000 regardless of the date that the report is subsequently run.

Time of Day

The user also has the option to narrow the search to a specific time of day.  If a multiple date range is selected, results, which match both the date and time ranges, will be displayed.

Test Methods

The Test Method number can also be entered.  If a Test Method has multiple attributes, the user has the option to select one or all of the attributes.

Test Method Groups

There is benefit to generating one report that will include a series of related test methods.  Pre-defined method groups can be selected by clicking the Use Selected Method Group checkbox.  A drop-down list is then presented from which one can choose the desired method group.  
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Defining method groups will be discussed later.

Equipment and Equipment Types

The displayed results can also be limited to a single Equipment Type or single piece of Equipment.

Sort Order

The results can be displayed in several different orders, which can be selected by the user.

Result Filter
The Result Filter check box when checked reveals some additional options:
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Again, checking the desired box yields the desired result.  One can easily ask a nonsensical question if one checks both the “Exceeds UCL?” box and the “Exceeds LCL?” box.  There will be no results that match both criteria!  Remember that the displayed results must match all of the selected criteria.  This is not an “OR” statement, this is an “AND” statement.  If both boxes are checked, you are not asking for the result which are either too high or too low, but the results where each individual result is both too high and too low, which is nonsense.  The program will not find any results, which match these selection criteria.  The option “Exceeds LCL & UCL?” is available for such a query.

Report Formats

There are 11 different report formats currently programmed.  They can be selected by toggling the appropriate checkboxes.
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There are 3 different output options, Screen, Print and Disk.  Some of these reports are generated inside of the program.  Others use Microsoft Excel for report generation.  

Clearing Information

A user may wish to widen the query by eliminating one or more selections.  The text edit boxes [IC #, Lot #, Method #] are cleared by selecting the box and using the [Del] key.  The drop-down boxes have a Clear button next to them for the same purpose. 

Single Parameter Graphs

Selecting the Graph – Disk option opens Microsoft Excel and creates a Microsoft Excel graph. Since a lot of things are occurring here, it may take several seconds to generate output.  Note, whenever running the graph option, it is recommended that Excel not be open before clicking on the display button. AutoData attempts to identify if Excel is open before execution of the link to Excel command, and tries to exit Excel.  If AutoData senses that Excel is open and cannot exit Excel, AutoData will notify the user that Excel is open and not proceed until the user exits Excel. 
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Follow the instructions on the screen.

(This problem is critical if using Windows 95 and 98, which can only support one instance of Excel.  NT and Windows 2000 support multiple instances of Excel and will open Excel twice if need be.  It is still recommended that Excel be closed before the graphing routines are run).

The single parameter graph looks like:
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This graph provides the date range, IC description, test method, user and date generated.  The results are represented by blue dots.  The decaying memory running average is represented by the dark blue line.  Orange and purple lines represent the control limits.  The decaying memory deviation (the moving equivalent to a standard deviation) is represented by the thin blue lines.

The decaying memory average is defined by:
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with the startup defined by:
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The decaying memory deviation is defined by:
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with the startup defined by:
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Where:

xn = the nth sample point

Xn = the decaying memory average at the nth point

 = the relaxation parameter [ > 1].  This is a measure of how far in the past we wish to consider.  If  = 1, then only the current information xn is considered when evaluating the process.  As  gets larger, we weigh more heavily the information from the past.

The Excel workbook that contains the chart also has a data sheet that contains the information for the chart.  The master file is an Excel Template called AutoData.xlt and is located in the Server\Data folder.  The data sheet “AutoData.xlt” and chart are configured for 200 data points but a good Excel user can change that value if desired.  Additional templates included are:

· AutoData200.xlt

· AutoData700.xlt

· AutoData9000.xlt

The numbers referring to the maximum number of data points the templates are configured to plot.  As expected, the larger the number, the more overhead and the slower the processing.  Simply change the name of the desired template to “AutoData.xlt” to set it as the default.

The data sheet links to the AutoData generated spreadsheet entitled data.xls.  The chart’s header information (or meta data) is linked from the AutoData generated spreadsheet entitled meta.xls. 

If the user wants to save the AutoData generated chart the links from the workbook generated from the AutoData.xlt file and the constantly changing data.xls and meta.xls files must be severed.  Selecting the data spreadsheet of the AutoData1.xls file, selecting all cells, copying, and then pasting values easiest does this.  An experienced Excel user should be able to do this without difficulty.  Then the AutoData1.xls file can be saved as another file for future use.  The AutoData.xlt template file is not affected.

Note, before returning to AutoData, it is recommended that Excel is exited.

Multiple Parameter Graphs

The multiple parameter graph option is controlled by the following part of the screen:
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The strategy here is simple: you perform the first query and store it in the Data 1 location.  You check the desired box to execute the desired command.  This creates two files on the server, “data1.xls” and “meta1.xls” for the data and the meta-data (meta-data is the header information or the description of what the data represents).  You can review what data is currently stored in the Data 1 location by clicking on the Data 1 button to reveal:
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In a similar fashion, you need to populate the Data 2 location and the Data 3 location with desired information. After Data 1, Data 2 and Data 3 locations have the desired data, Generate either a 2 parameter or 3 parameter graph by checking the appropriate box.  Upon execution, Excel again launches, this time using the AutoData2.xlt file to display a two parameter graph:
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or AutoData3.xlt file to display a three parameter graph.  Both AutoData2.xlt and AutoDat3.xlt are configured for up to 200 data points.  It is a simple task to expand this but the performance will suffer.

Histograms

This option generates and Excel spreadsheet and graph.  It is a histogram of the specified parameter(s).  An example is as follows:
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The software does several things.  First, it draws vertical lines for the control limits and the alarm limits.  Then, it constructs normal distribution curves using a 1-sigma and 3-sigma spread between the control limits (thin dotted lines).  Finally, it constructs the actual distribution curve from the data.  In this example, the process is out of control.  There are 3 different peaks, only one of which is within the control limits.

This second example shows a process in control, with the actual distribution falling on top of the 3-sigma distribution:
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Thomas Complete Report

This is a report specific to the Thomas Engineering Pill Coating equipment.  This option only appears if the software is configured to support this equipment.  This generates an Excel workbook with 1 worksheet displaying up to 50,000 data points for each of 10 measured parameters, and 10 graphs, one for each data point.  The time and date range is specified by the user.

Saving Pre-defined Reports

After a report query has been fully defined, the user can save the defined report by clicking on the Save Report F4 button in the upper right.  The screen transforms to:
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and the user simply types in a description for the report and once again clicks the Save Report F4 button to complete the process.  The user is now ½ way to completing a Quick Report.  Since there is some utility in having multiple reports executing with the touch of one button, a report group has to be defined to be included in the Quick Report drop down menu.  This process is discussed later.

Report Local Data

This option presents a simple report to allow the user to view or print the data stored on the local machine and not yet transferred to the Server.

Report Users

Report Equipment

Report Equipment Type

Report Methods

Report Attributes

Report Method Groups

Report Method Items in Groups

Report Inventory Groups

Report Inventory Items in Groups

Report Saved Reports

Report Report Groups

Report Customers

These reports are simple lists. The screen becomes:
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and can be printed using the Print button.

Report Inventory Items

There are two sort orders available.  In either case, the screen becomes:

[image: image118.png]O futabata Lab Information Management System - © futoSott an... MEIE]

Eile Edit fnter LogData Report R4/Edit Lmport

Filters:
¥ [0niy those ICs created in this date range: Execute

start: [10-Jul -2008 =] Sto

I Only those ICs with samples

17- dul 2008 %)

Cancel

I 0nly those ICs with MSDS sheets

Sort Order: <

Output Options:

" screen [V Printer [ Excel

Report Formats:
I¥ Simple Report  (Number, Description, Creation Date]

I Complete Report (Al Fields)

7 MsDS Report  (Number, Description, MSDS Date)





If IC numbers are entered manually or via import from another program, a date stamp is placed on each IC number when it first appears in the AutoData software.  One can print a subset of the IC number list based on the date range entered.  This is valuable when the import feature is used and the user wants to print only the list of recent IC additions.

The other toggles that are listed above are straightforward.

Report QC Specifications

The screen becomes:
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This screen is consistent in behavior with the other screens and can be used to print all specifications or only those which match the entries.

Report QA Specifications

The purpose of this function is to print out one or more QA Specifications.  For a complete description of QA Specifications, see the discussion under the Add/Edit Menu.  The screen becomes:
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The user must determine the method for selection of the QA Specs to be printed;  By IC or By QA Spec.  The user also determines the reports to be printed.  There are three reports:

· QA Spec Sheet 

· Revision Sheet

· IC Mapping List 

Under normal circumstances, the QA Spec is printed with an expiration date two weeks after printing.  By checking the No Expiration Date box, users with proper authority can print a Master Copy of a QA Spec.  The Master Copy does not have an expiration date.

If the By IC option is selected, the screen becomes:
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If the user knows the IC number, he/she can enter it directly.  If not, the standard IC picker screen can be used to determine the IC number.  Once an IC number has been selected and entered, the screen becomes:
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In this fashion, a list of QA Specifications can be generated.  The list can be as long as required.  Individual items can be removed from the list by double clicking on them.  The list can be purged by using the Remove All Entries button.  When the list is complete, the Execute button prints all of the items on the list.

In a similar fashion, the By QA Spec button generates the list using the QA Spec numbers.

Report QA Spec Summary

This is a simple summary list of the QA Specifications.  Three sort orders are presented.

Report QA Spec -> IC Map

This is a simple summary list of every QA Specification and the IC #s associated with each one.

Report IC Map -> QA Spec

This a list of every IC number that has been assigned to a QA Specification and the QA Specification to which the IC # has been assigned.

Import Menu
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This feature is site-specific and beyond the scope of this general manual.

Data Acquisition Considerations

It is important to note that AutoData will run using Windows 95, Windows 98, Windows NT 4.0, Windows 2000 and Windows ME.  However, the data acquisition routines have only been certified under Windows NT 4.0.  Although the data acquisition routines appear to function using these other operating systems, the other operating systems are not stable enough to be true 24 x 7 x 365 systems and others have found them to crash after several days or weeks of operation.  It is hoped that AutoSoft can certify sometime in the near future Windows 2000 for 24 x 7 x 365 operation.  AutoSoft holds little hope that the other platforms will perform adequately for this function. 

Addressing ADAM devices

The ADAM hardware devices are the blue modules in the hardware enclosure.  Each device must have a unique address assigned using the ADAM.exe program that can only run under a DOS shell.  It is easiest to run this program using a DOS boot diskette with the ADAM.exe program on the diskette.  When the program is first launched, the screen looks like:
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If the ADAM modules are correctly connected to the network, the software will list all devices.  The screen will look like this:
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In this example, there is 1 ADAM 4017 with an address of 30.

The program is very simple to operate, and the user can follow the on-screen instructions to address the ADAM 4017 modules.  In the case of Thomas Enginerring, the two ADAM devices should be addressed to values of 30 and 31 respectively. As a general rule, all AutoSoft enclosures use addresses starting at 30 for ADAM 4017 devices.  Any address from 0 to 255 is a valid address.  Each ADAM device needs to have a unique address.  All other options should be kept at the default settings.  The ADAM 4000 User Manual explains the operation of this software in detail in Appendix D.

There should be no reason for the user to have to address the ADAM modules again.  If an ADAM module malfunctions, the user should contact AutoSoft for a replacement.  AutoSoft will deliver a replacement module pre-addressed correctly for the application.  

	Confirmation checklist

	ADAM Devices On Network
	Address
	Initials
	Date

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	


Advantech ActiveDAQ ADAM drivers

The ADAM data acquisition hardware modules from Advantech need drivers.  They are pre-installed.  The installation program is included if needed.
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The software indicates it is for Windows 95 but it also works under NT.  After the software has been loaded it must be configured.  Launch the Advantech Driver Installation program which is in the Start\Programs\Advantech Driver for 95 menu and select
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Click on Add:
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and Install:

[image: image129.png]Attached Devices:





Click on Port and change to COM1:
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	Confirmation checklist

	Item
	Initials
	Date

	COM 1 Port configured as outlined above
	
	


Click Okay, 
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then Add:
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Then Install:
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Here, the proper ADAM module type must be selected from the drop down list, and the proper module address must be entered.  Click Okay.  

Continue this process until all ADAM modules have been added to the list.
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The numbers entered for the addresses of the ADAM modules accessed by the AutoData data logging modules represent the sequential order of the ADAM devices as entered on this list.  This illustrates a proper configuration for the Thomas Engineering screen.
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Here, Address 0 talks to the first ADAM device on the list that is listed as 


000:ADAM 4017 Address=30 Dec.

and Address 7 talked to the seventh ADAM device on the list that is listed as:


007:ADAM 4017 Address=31 Dec.

A little confusing, but it works!

For the ADAM 411D screen one would have:
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	Confirmation checklist

	Code
	ADAM Description
	Address
	Initials
	Date

	000
	
	
	
	

	001
	
	
	
	

	002
	
	
	
	

	003
	
	
	
	

	004
	
	
	
	

	005
	
	
	
	

	006
	
	
	
	

	007
	
	
	
	

	008
	
	
	
	

	009
	
	
	
	

	010
	
	
	
	


COM1 Port

The hardware must be connected correctly to work correctly.  First, the RS-232 serial port [COM1] at the back of the computer must be connected to an ADAM 4520 protocol converter using a 9 pin serial cable.  The COM1 port will be labeled as such.  It may also be labled with an “A”.  Many computers have more than one COM port.  The software will only work on the COM1 port.  The Windows NT control panel, “Ports” must be configured as follows:
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	Confirmation checklist

	Item
	Initials
	Date

	COM 1 Port configured as outlined above
	
	


ADAM 4520 protocol converter

The ADAM 4520 protocol converter must be connected to the COM1 port using a standard 9 pin RS-232 cable.  Radio Shack #26-117 works fine.  Chapter 2 of the ADAM 4000 User Manual gives the necessary details.  The default settings of the ADAM 4520 are used.  A 12-30 VDC power supply is required as described in the User Manual.

RS-485 communication wires

RS-485 communication is very forgiving.  The details of the wiring are described in the User’s Manual.  This author has not yet experienced a situation where communications problems have existed because of inadequate wiring.  Although cable specifically designed for RS-485 communication is recommended, this author has used speaker wire, zip cord and EtherNet cabling without problems in the past.

Hardware enclosure

[image: image139.wmf]
This enclosure has been designed specifically to interface with the Thomas Engineering COMPU-LAB 24.  The large connector plugs into the COMPU-LAB 24.  The 110 VAC outlet plugs into a standard wall outlet.  The enclosure is connected to the ADAM 4520 using the terminal blocks labeled DATA+ and DATA-.  These connect to the DATA+ and DATA- terminals of the ADAM 4520.  This device is designed to be NEMA 4.  There is an on/off switch inside the enclosure but the case must be opened to access it.  The devices can be left in the power-up state indefinitely but it is recommended that the power supply be toggled remotely.

Any problems with the enclosure should be referred to AutoSoft.

	Confirmation checklist

	Item
	Initials
	Date

	Enclosure is properly assembled, free from defects
	
	

	Enclosure cover is mounted and tightened
	
	

	Enclosure is mounted on a vertical surface, away from water and direct splash potential
	
	

	Enclosure is powered by a 110 VAC 60 Hz 15 amp electrical circuit with ground fault interrupter.  Other electrical appliances (if any) on the same circuit will NOT create voltage spikes or drops due to excessive current draws as part of their normal operation (e.g. an air conditioner will create a intermittent voltage drop when the compressor engages).
	
	

	Enclosure is connected to the Comp-U-Lab through the Ampernol connector.  Connector is properly and firmly attached.
	
	

	Enclosure is connected to the ADAM 4520 converter through appropriate wiring
	
	

	ADAM 4520 is connected through power supply to 110 VAC 60 Hz circuit
	
	

	ADAM devices light up when power switch is turned on
	
	


Appendix 1 Automatic updater program for users of AutoData

In order to facilitate the updating of AutoData.exe files across a network, the ADUpdater.exe program has been created.  It needs to reside in the same folder on the user’s machine as the AutoData.exe file.

Note: In order to use the ADUpdater.exe program, the AutoData.exe program must not be running.
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A shortcut can be placed on the desktop or in the start menu as desired.  When launched for the first time, the user is asked:
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In this example, a folder exists on the network labeled Latest_AutoData.  Located in this folder is the new version of the AutoData.exe file.  The ADUpdater.exe will then replace the old ADUpdater.exe file on the local machine with the new ADUpdater.exe from the selected folder.  The software creates a file entitled Update.mem.  This file remembers the location of the new AutoData.exe file so that the above screen does not appear when the ADUpdater.exe is run again.

Appendix 2 Local Cloning of AutoData Server Files

AutoData is a multi-user program that requires a multitude of database files.  In most cases, the Server files are located on a server as part of a local area network.  In order to use AutoData, the user must be connected to the Server.  The ADClone.exe program allows a salesperson or a technician access to AutoData information while not connected to the local area network.

The first step is to create a Server Data folder on the user’s local hard drive.  The ADClone.exe program is located in this folder.  
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In the above example the adclone.exe file resides in an otherwise empty D:\AutoData\Server\Data folder.

Upon execution of the adclone.exe file, the user is asked to locate the Beacon.txt file in the identical fashion as outlined above in Resetting the Beacon:
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The ADClone.exe will then copy the entire contents of the selected folder into the folder where the ADClone.exe file resides.  This file remembers the location of the selected Server Data folder so that the above screen does not appear when the ADClone.exe is run again.

The user must then Reset the Beacon to the local clone of the Server Data folder to use it.  

Note: Any changes made to the local clone will not be reflected in the master.

Appendix 3 Sewer Discharge Data Transfer Program for Bradford Soap

Bradford Soap has a legacy system for data logging of sewer discharge pH.  A file called “data.dbf” contains the information that can be imported into AutoData.  A special copy of AutoData has been installed in the N:\_R&D\AutoData\Sewer folder:
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To transfer data from the legacy system:

1. Place a copy of the “data.dbf” file in the N:\_R&D\AutoData\Sewer\Server\Data\ folder.

2. Execute the N:\_R&D\AutoData\Sewer\Server\Data\autosewer.exe program pictured above.  

3. You may be prompted with a screen to select a code page. Select Standard Macintosh.

4. You are asked to enter a date range using the following screen.  It is important that you keep track of the date ranges you have already entered since it is possible to skip data or enter data twice. 
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5. Discard the N:\_R&D\AutoData\Sewer\Server\Data\data.dbf file after transfer is completed.  Make sure you do not discard the

N:\_R&D\AutoData\Sewer\Server\ad_data.dbf file or the

N:\_R&D\AutoData\Sewer\Local\data.dbf file.  Both are needed to run AutoData.

Last updated on 10/3/2000 for dates including 9/30/2000.

Appendix 4 Quick Instructions for running Quick Reports

1. Launch the AutoData program in the usual fashion.

2. Log on.  For example, use name “Supervisor” and password “super”:
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3. If this is the first time today a report is to be run, Update Local Data by clicking on the Update Local Data menu item.
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4. Wait up to 30 seconds for this task to be completed. 

5. Type [Ctrl] – [R] to access the report menu: [image: image149.png]O [-[CIx]
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6. Click on the Quick Reports [Arrow Down] to access the list of Quick Reports: [image: image150.png]File Edit Enter LogData Update Local Data. Report Add/Edit Import

Select Equipment Type: —
ﬁ. clear] —————
Skip Quick Reports option fancel 5|
239155 Lot Report Save Report F4
210527 Lot Report Sefect User: Output
216582 Lot Report =[ctear] pisk screen Print
216600 Lot Report - — “
216721 Lot Report [T Result Firter? G D50
816762 Lot Report . F Comprehensive 7 [
Start bate: Stop Dater B somirons s
96-5ep-1999 ~|  [06-Sep -2000 < I 6raph [l sl
[ Relative Dates (for saved reports) [ Comprenens2 [ [
T iso Filter by Time of Day = Somary 2 EE
[ Comprehenss [ [
- I out of Spec [l sl
Enter Method Number or F6 o search: Ollotsummary [ O
~OR- T Use Selected Method Group I Lot Summary2 [
fll Method Search F6 [Multiple Parameter Graphs: s P
™ save to 15t Data il Datan]| Soner2te Eraph
™ save to 2nd Data File Data || 2 Porometer I T
I Save to 3rd Data File Data 3|3 Parameter
Sort order: Notes:
Slciear] | [





7. Select the desired Quick Report and wait up to 2 minutes for the printer to print it.

Appendix 5: Comprehensive Instructions for Data Entry Users

Certain users are configured for data entry only.  Upon startup of AutoData, select a known data entry user from the list.  In this example, use 732634:
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Double-click on “732634” or highlight it as illustrated above and hit the [return] or [tab] key on the keyboard.  The screen then becomes:
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In the case of this example, “732634”, the password is nothing at all.  Simply hit the [spacebar] once and then hit [return] to log in.  The screen becomes:
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There are only four steps for the data entry user to complete in this example.

1. The lot number.  Simply enter the lot number in the lot number slot.  The program, upon startup, starts in this block.  In this example, enter the lot number “LOT123” and then the [return] key to reveal:
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Note how the result next to the “Marginal” attribute has become highlighted and the value “  0.0000” appears there. 

2. Enter the test results. Enter a result of “6” for the “Marginal” value and then hit [return] on the keyboard.  Because “6” is higher then the control limits, an alert is issued:
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This is just a warning to minimize data entry errors.  After the user clicks on the [OK] button or hits the [return] key, the screen becomes:
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Note that the “Marginal” result is still highlighted, but “  0.0000” has now appeared as the “Unacceptable” result.  As indicated by the large red letters on the right side of the screen, the [tab] key and the [shift][tab] combination are used to move from field to field.  Hitting the [tab] key once reveals:
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Now the “Unacceptable” result is highlighted and ready for data entry.  Enter a value of “1” there to reveal:
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Note how the “1” is not aligned properly and there are no zeros after it.  This occurs after the “1” is typed but before the [return] key is pressed. Hitting the [return] key will result in the following:
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Note the “Save Entry F4” button in the upper right corner.  This button must be pressed or the [F4] key along the top of the keyboard must be pressed to record the result.  If the user presses the [F4] key while the result field is still bright yellow, a message occurs:
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The user must hit the [tab] key to exit the data entry field before the information can be saved.  Hitting the [tab] key reveals:
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3.
Now the active field is the “Notes” field and specific notes pertaining to the sample can be entered here if desired:

[image: image162.png]O

Eile Edit Enter LogData Report Add/Edit Import

[-[OIx]

Quit F3

Save Entry F4

1C Number Equipment Type:
732634 ST
PEG US 3.25 CLEARASIL FP76476 PKD Fquipment:

9

Enter Lot Number:  [LOT123
11/16/2608 | Time:[11:25:30

Daty

Current Metho
PG_TAMU

PEG Carton Appearance

Customer Code and Name:
PE6120

Procter & Gamble Inc.

Select Attribute from list:
[Attribute Result
Marginal

uct: 1.0008
uAL: 1.8008

Use the [TAB]
key to move
forward and

the
[Shift][Tab]
keys together|
to move
backward

LAL: 0.0000

Lol 6.6000

Note:

[Specific note pertaing to this sampie





The user can type up to 40 characters in this slot.

4. Save the data by clicking on the [F4] key on the top of the keyboard or clicking on the “Save Entry F4” button in the upper right.  The screen becomes:
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Observe that the results have been reset but the Lot Number and Notes are retained.

The information continues to accumulate on the local computer.  The status can be checked using the “File->Status” command:
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which reveals:
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In this example there are 46 records awaiting transfer to the Server.  In order to transfer to the Server the program must be exited and a user with sufficient privileges to transfer to the Server must log on and execute the command.

Appendix 6: Quick Instructions for Data Entry Users

1. Log on as a user who has Data Entry Priveledges.  In our example, use:

User: “732634”

Password: “”,  {there is no password, the correct entry is blank or nothing} 
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2. Enter the lot number

3. Enter test results

4. Enter notes if desired.
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5. Save Entry using the [F4] key.

6. Later, a qualified user must log on and transfer data to the server. 
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